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Computer Labs Rules, Procedures, and Regulations 
1. Students are expected to exhibit ethical behavior at all times. 

2. Eating (including hard candy), drinking, and chewing of gum in the lab by students or adults are NOT permitted at 

ANY time. 

3. Students are NOT to move any computer, peripheral equipment, or piece/part of any equipment. Contact the 

teacher or lab supervisor concerning any problem with any of the equipment! 

4. Grooming (including hair brushing) or applying of cosmetics in the lab is not permitted. 

5. Felt tip pens, sharpies, and paint pens are not permitted in the computer lab. Use ball point pens only. 

6. Students are not permitted to remain in the lab unless supervisory personnel are present. 

7. When the supervisor leaves an empty lab, all doors will be shut and locked. 

8. Students are not permitted to sit on the desk/counter tops, nor on the backs of chairs. 

9. All students who use computers at Redlands High School will have completed and signed the Appropriate Use 

Policy and will have received a copy of both the “Procedures and Regulations” and the “Basic Computer Lab Rules” 

governing the ethical and responsible use of computers and their associated facilities. Students who have not 

completed the agreement form will NOT be allowed to use a school computer. NO Exceptions!! 

10. During periods 1 through 6, individual students must be referred to a computer lab/classroom (Rms 1, 2, 411, & 

408) by a staff member for a specific purpose. A written pass is required.  

11. Computer classrooms (Rm. 1 and 411) are open before school, after school, or during lunch only at the discretion 

of the instructor. A written pass is NOT required during these hours.  
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12. Students may be assigned to specific computer stations. Students are to leave their stations as they found them: in 

working condition, neat, and orderly! Students will be held responsible for any damage caused to the computer 

station and for the removal of any part of the station. 

13. NO software of any kind including programs, applications, files, INITs, CDEVs, etc. may be installed on the hard 

drives of any computer on campus. 

14. NO changes, modifications, customization, or upgrades are allowed to the control panels, computer ID information, 

network ID information or other computer parts. 

15. Offensive, deviant, outrageous or antagonistic materials, or that of a questionable nature, are not permitted. 

16. Individual software applications may be run for students if the program is approved and submitted in advance by a 

staff member. The program must be for academic use ONLY. 

17. Other than those designed for instructional learning and approved by staff, no headphones, games or audio CDs 

are allowed. 

18. At all times, Rooms 1, 411, & 408 are available ONLY to students who are assigned to a class in that room. 

Students in these classrooms are responsible for all rules and guidelines in effect in the computer labs. 

19. A student who breaks established rules will be asked to leave and may lose the privilege of using the labs for the 

entire academic year. Appropriate records will be maintained by the lab support person or teacher. 

20. Refer to the Academic Code of Conduct for additional standards required of all students. 

CELL PHONES, IPODS AND MP3 PLAYERS 
DO NOT use cell phones, iPods, or other MP3 players in class at anytime except when permitted by the teacher for 
INSTRUCTIONAL PURPOSES ONLY!  
é NO, you may not charge your phone, your iPod, or any other electronic device off of the computers.  
é NO, you may not use iTunes to store your own music and video files for use on your iPod.  
é NO, you may not use the computers to download ring tones or anything else. 
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é While there will be times when headphones are used in class as part of the class work, HEADPHONES ARE NOT 
TO BE WORN AT ANY OTHER TIMES, NOT EVEN IN ONE EAR!!! 

Instructional Tools, Methods, and Strategies 
Primary instructional methods and strategies include individual and group project-based learning. Students complete 
projects independently and with teacher guidance. Students in Multimedia Design CP, Advanced Multimedia Design and 
Video Documentary work in small groups. Other instructional methods and strategies include lecture, sample work, 
reading, and Internet research. Lecture notes serve as introductions to projects for each class unit. In addition, sample 
work by previous students, and professionals are used as examples. A textbook, lab manual, and supplementary readings 
are used to help familiarize students with the elements of art, the focus of the individual projects, and to aid them in the 
use of the software and hardware. The Internet is used as a research tool to support student projects, and find production 
materials like scripts and stock footage. 
DUE DATES AND LATE WORK 
The due date for an assignment is the date the assignment’s score is recorded into the online grading program. Work is 
accepted after the due date, but not after the close of the quarter or semester grading period. 
HARDWARE AND SOFTWARE 
Room 1 is equipped with 38 Apple Intel iMac computers, one Apple PowerMac computer used for editing in Final Cut Pro. 
These computers are used everyday in class by many students. It is everyone’s responsibility to keep them clean and in 
good working order. 
The computers in Room 1 are loaded with a variety of software titles used to teach the multimedia courses. The software 
is licensed to the school and is not available for checkout by the students. 
TEXT BOOK 
Ragans, Rosaline, Art Talk, Glencoe/McGraw-Hill, 1995. 

Course Descriptions 
MULTIMEDIA DESIGN CP (GRADES 9-12) 
UC Category F approved 
This one-year introductory level multimedia course uses an integrated/correlated curriculum and has a balanced emphasis 
on the standards. Students express themselves both creatively and visually. They learn the art elements as a basic 
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language of art and begin to learn basic art techniques through digital applications like Pixelmator. The purpose is to 
enable students to understand and appreciate artistic expression through multimedia, and to talk and write with 
discrimination about the media studied. The goal is to educate students in the art, craft, and technology of multimedia 
including image manipulation and web site design. The second semester is focused on video production and animation. 
Students learn a variety of techniques and media applications including animation, non-linear digital video editing. The 
class offers intensive hands-on production through project-based assignments. The course strives to nurture individual 
talent and skills, and encourage students to become creative, and thoughtful practitioners in the world of computer media.  
MULTIMEDIA 2 (GRADE 10 ONLY)  
Prerequisites:  
é “A” or “B” in Multimedia Design CP.  
é 2.0 GPA 

Multimedia 2 is a sophomore level 5-credit course designed to bridge the gap between Multimedia CP and Advanced 
Multimedia/Video Production. Students are given special and specific assignments to complete for the Friday Show, and 
other class projects. Through these projects students develop and refine their skill sets in still imaging, animation, video 
production, and editing. All projects address both the Common Core and CTE standards. 
ADVANCED MULTIMEDIA DESIGN (GRADES 10-12) 
é UC Category G approved 
é Can be taken once 
é Articulated with RTF 67 at Riverside Community College 

Prerequisites:  
é “A” or “B” in Multimedia Design CP.  
é 2.0 GPA 

This course is comprised of a collection of students working together in small groups to complete cross-curricular school, 
group and individual media projects. This semester long course uses an integrated/correlated curriculum emphasizing the 
standards and teaches advanced video editing techniques using Apple’s Final Cut Pro. This is an advanced level 
multimedia course focused on multimedia production. Students express themselves both creatively and visually based on 
research and development of artistic skills and techniques. Students create artistic projects that express their ideas, 
feelings and interpretations of visual, personal and aesthetic experiences. 
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VIDEO PRODUCTION (GRADES 10-12) 
é UC Category G approved (pending) 
é Can be taken multiple times 

Prerequisites: 
é “A” or “B” in Multimedia Design CP.  
é 2.0 GPA 
é 1 semester of Advanced Multimedia Design 

The Video Production course focuses third and fourth year students in the art and process of creating long-form video and 
DVD projects such as sports documentaries and personal projects. This semester long course develops fundamental 
skills introduced in the Multimedia Design CP and Advanced Multimedia Design courses through the production of a 
variety of school-focused video documentaries and student-authored personal projects. Each student contributes to class 
projects that will span the entire school year. Each phase of the project is graded as components to over-all grades. Each 
student also writes and produces one 5-minute personal project each semester. 
FILM AS LITERATURE/SCREEN WRITING (GRADES 11-12) 
é English Elective 
é No prerequisite 
é Textbook: Story by Robert McKee 

Screenwriting as Literature is an intensive writing, theory-based, advanced level course aimed at enriching the experience 
of aesthetic literature and storytelling concepts through the visual medium of film. The students begin to understand film 
narrative by researching periods of major story evolutions within film history and looking at many of the films that defined 
those periods. Story by Robert McKee will help students understand how narrative and characters work in all literature, 
not just film. Students will use creative writing techniques when writing dialogue and action. Students will learn how to use 
Final Draft, an industry standard program, to help perfect the art form in a way acceptable and appreciated by professional 
institutions. Students will learn best practices and advanced techniques that can be used during the writing process, and 
once finished students will know how to improve and distribute their screenplays. 
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Scope and Sequence 
 

Semester 1 Semester 2 

Ye
ar

 1
 

Multimedia Design CP (45 Hours) 
é Developing Your Online Identity 
é My Profile Page and Blog 
é Musical Composition 
é Imaging Skills 
é Layers/Selections 
é Painting/Blending Modes 
é Art Concepts 
é Elements 
é Design 
é Web Imaging 
é .JPG/.GIF/.PNG/.WebP 
é Buttons/Banners/Animated .gif 
é Podcasting 
é Web Portfolio 

Multimedia Design CP (45 Hours) 
é Editing Skills 
é Titles/Transitions 
é Video/Audio Effects 
é Animation Skills 
é Bouncing Ball 1 & 2 
é Composition Skills 
é Scoring 
é Production Company Wiki 
é Video Production Skills 
é Camera 
é Sound 
é Lighting 
é Production Process 
é DVD Authoring 

Ye
ar

 2
 Advanced Multimedia Design (45 Hours) 

é Final Cut Pro X 
é Terrier TV  
é Short Script 

Video Production (45 Hours) 
é Motion 
é Terrier TV  
é Festival Projects 
é Portfolio Update 

Ye
ar

 3
-4

 Screenwriting as Literature/ (45 hours) 
é English Elective 
é Structure and Story 
é Film History 
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FOCUS: Digital Dogz Club 
The Digital Dogz is the club within the Advanced Multimedia Design course that handles the distribution of project 
responsibility, fundraising, and public presentation. All projects are supervised and graded by the teacher/advisor. 
OFFICERS 
é Teacher/Advisor: Chief Educational Officer (CEO). 
é President: Student liaison with Teacher/Advisor. Updates club constitution. 
é Vice President/Equipment Manager: Equipment check in/out, maintenance, repair, equipment purchase with 

Treasure/Business Manager. 
é Secretary/Publicist: Publicity for all public projects. Keeps track of all Board meetings. Keeps all production 

notebooks. 
é Treasure/Business Manager: Fundraising, works with Finance Office, and equipment purchase with Equipment 

Manager. 
é Board: Includes: CEO, President, Vice President/Equipment Manager, Secretary/Publicist, and Treasurer/Business 

Manager. The Board meets regularly to consult with the CEO on decisions effecting class. 
12 COMMANDMENTS 
Courtesy of the Digital Dogz class of 2011. 

1. Complete pre-production. 
2. Secure talent quickly. 
3. Write a script and use it. 
4. Make a work schedule. 
5. Follow the Rule of Thirds. 
6. Use a tripod. 

7. While operating the camera, keep your back to the sun and white 
balance the camera. 

8. Communicate clearly. 
9. Do your work in class (FOCUS). 
10. Use the microphones correctly. 
11. Shoot cutaway shots. 
12. Wear club shirts on Fridays. 
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FOCUS: Professional Editing and Production 
(AS: 1.0, 2.1, 2.2, 2.3, .24, 2.5, 2.6, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.7, 3.8, 3.9, 4.1, 4.2, 4.3, 4.4, 4.5, 4.6, 5.1, 5.2, 5.3, 5.4, 6.3, 6.4, 6.6, 7.1, 7.2, 7.3, 
7.4, 7.5, 7.6, 8.1, 8.3, 8.4, 8.5, 8.6, 8.7, 9.1, 9.2, 9.3, 9.4, 9.6, 9.7, 10.1, 10.2, 10.3, 10.4, 11.1, 11.2, 11.3, 11.4, 11.5)(PS: A1.1, A1.2, A1.3, A1.4, 
A1.6, A1.7, A1.8, A1.9, A2.1, A2.2, A2.3, A2.6, A2.7, A2.8, A2.9, A3.1, A4.2, A4.3, A4.4, A5.1, A5.2, A5.3, A5.4, A5.5, A5.6, A5.7, A7.1, A7.2, 
A7.3, A7.5, A8.1, A8.2, A8.3, A8.4, A8.5)(NETS: 1a, 1b, 1c, 1d, 2a, 2b, 2c, 2d, 3a, 3b, 4a, 4b, 4d, 5a, 5b, 5c, 5d) 

Semester grades are divided into two categories: 
é Class Projects: Festival, Friday Shows (50%) 
é Personal Projects: Original Screenplay, Final Cut X (50%) 

Finished projects will be viewed in class and critiqued based on a rubric. The creator(s) of the project must be prepared to 
discuss their own work. Grades are given by the instructor and are based on the quality and creativity of the work 
completed. Each advanced multimedia student keeps a 3-ring binder in Room 1 of his or her pre-production work, and 
written work. 

PROJECTS: Class (50%) 
FESTIVAL PROJECTS 
Throughout the year, students will submit small group projects to other festivals including the annual San Bernardino 
Valley Festival of Student Films. Student attendance at the Valley Film Festival is HIGH recommended. 
THE FRIDAY SHOW 
Three “Friday Show” projects are produced first semester during Advanced Multimedia: 
é Welcome Back 
é REV Week or Halloween Special 
é Holiday Special 

Students will work in small groups lead by the Digital Dogz officers to complete segments for each of these projects. 
DVD DOCUMENTARY 
The major fundraisers for the Digital Dogz are the sale of DVD documentaries. The art of documentary includes both 
education and entertainment. The goal is to create a finished project that is both informative and interesting. Conduct 
research and present it in an entertaining way. Engage the viewer with fascinating facts and stories on a topic related to 
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the community. Use the elements of art to express mood. Students must produce a video research project about an 
element of their community. The DVD Documentary Team is responsible for their work schedule and deadlines.  
DVD DOCUMENTARY PROCESS  
é The Project Producer is responsible for the planning and creation of Documentary DVDs. The Executive Producer 

manages the Production notebook and oversees all aspects of production including editing. The Executive Producer 
completes a work schedule for the entire project and determines the necessary due dates. The Executive Producer 
makes sure that all pre-production is complete BEFORE the sports season begins.  

é The Segment Producers divide the events equally to produce and edit in Final Cut. The Segment Producers are 
responsible for the segment preproduction and for directing the Talent and Camera Operators.  

é One student acts as Talent if necessary for voice-over or other on-camera assignments. The Talent is also 
responsible for scoring the segments in GarageBand, writing original musical compositions, and obtaining rights to 
use any copyrighted music.  

é The Camera Operators are assigned to shoot videotape at events. The footage is then edited and prepared for the 
DVD by the Segment Producers.  

é Completed segments are then given to the Project Producer to use in constructing the final DVD. 

PROJECTS: Personal (50%) 
FINAL CUT PRO X 
This hands-on course introduces students to the primary feature set and basic interface of Final Cut Pro. In this course 
you learn to perform basic editing functions while familiarizing yourself with the user interface. Topics include basic setup, 
adjusting and customizing preferences and settings, capturing video and audio, various editing and trimming techniques, 
Ripple, Roll, Slip and Slide tools, audio editing and audio creation, finishing and final output. 
LESSONS 

1. Exploring the Interface 
2. Importing Media 
3. Organizing Clips in an Event 
4. Building the Rough Cut 
5. Finishing the Rough Cut 
6. Fine-tuning the Rough Cut 

7. Applying Transitions 
8. Working with Sound 
9. Working with Titles, Generators, and Tremes 
10. Retiming and Transforming Clips 
11. Applying Effects and Enhancing Color 
12. Sharing Your Project 
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QUIZZES AND FINAL 
An online quiz will be given for each lesson. Quizzes must be taken in Room 1 during class. Students may not take a quiz 
with their textbook open, or with Final Cut Pro open on the computer (or any other computer around them). Students may 
not copy and paste or write down the correct answers while taking the quiz. If a student is dissatisfied with his or her quiz 
score, they may review their study materials and retake the quiz one time in class only. Quiz scores are calculated into the 
students’ semester grade. 
A Final Cut final exam is administered on the day of the first semester final. 
ORIGINAL SCREENPLAY 
Write a 5-page screenplay using these formatting guidelines. Subject matter is up to the student, however it must be 
appropriate for a public high school. There are to be no references to any intoxicating substances, foul language, and 
overly violent or overly sexual themes. Suggestion: write about an experience you had or imagined from your childhood 
around the age of ten years old. It is suggested that scripts be used for personal projects and are due as part of the pre-
production. Story, by Robert McKee, will be used as a reference text. 
Each screenplay must have a: 
é Protagonist (hero or main character) (Story p. 136-141) 
é Antagonist (villain or opposing force) (Story p. 317-318) 
é Plot (story to tell) including a beginning, middle, and end. (Story p. 43) 

Each plot must include 5 parts: 
1. Inciting incident (radical upset to the balance of forces in the protagonist’s life) (Story p. 189) 

2. Progressive complications (rising action) (Story p. 208) 

3. Crisis (decision/quest) (Story p. 303-304) 

4. Climax (success or failure) (Story p. 309) 

5. Resolution (falling action) (Story p. 312) 

FINAL DRAFT 
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Final Draft 8 is the number-one selling screenwriting program designed specifically to write scripts for film, television and 
theater, Final Draft automatically formats and paginates to Industry standards with two simple keystrokes. There’s no 
faster way to take an idea from initial concept through to FADE OUT. 
Before you launch the application, follow the Quick Start tutorial here: http://www.finaldrafttutorial.com 
EXPOSITORY WRITING 
Students must complete all of the following written assignments. 
PRODUCTION JOURNAL 
Students are given a composition book at the beginning of each quarter. These composition books are used to write their 
personal thoughts about class, projects, and life. Composition book are collected at the end of each quarter to check for 
completed entries. Two entries a week are required. Some class time may be given for writing. Online entries or blogs will 
not be accepted. 
PRODUCTION REPORTS 
At the end of each project, each student will complete a Production Report. These reports will be filed to their Blog on 
Terrier Net. Production Reports must be no less than 100 and no more than 300 words that include a detailed description 
of the project they completed, and their role in the production. The goal of the production report is for students to reflect on 
their experiences and efforts and create personal goals for their next production.  

GUIDE: Basic DSLR Operation 
Two Canon 60D Digital Single Lens Reflex (DSLR) cameras are available for use in class. They shoot in both still and 
movie mode. Make sure that an appropriate battery and SD card are inserted. Also make sure the power is turned on. 
SHOOTING MODES 

1. To change the shooting mode, rotate the Mode Dial. Modes include: 

é Fully Automatic 
é Disable Flash 
é Creative Auto Shooting 
é Portraits 
é Landscape 

é Close-ups 
é Moving Subjects 
é Night Portrait 
é Movie Mode 
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FULLY AUTOMATIC SHOOTING 
1. Set the Mode Dial on the left side of the camera body to the green rounded rectangle. 

2. Aim any AF (auto focus) point over the subject. 

3. Focus the subject. Press the shutter button halfway and the focus ring will auto focus. 

4. Take the picture by pressing the shutter button completely. 

SHOOTING MOVIES 
1. Set the Mode Dial to Movie Mode (camera). The image will appear on the LCD screen. 

2. Focus the subject. Use auto or manual focus by adjusting the AF/MF switch on lens. Press the shutter button 

hallway to use auto focus. 

3. Press the camera button next to the red dot above the menu button to start shooting a movie. Press again to stop. 

MANUAL EXPOSURE SHOOTING 
1. Set the Mode Dial to Movie Mode (Camera). 

2. Press the MENU button on the camera body. Look at the LCD screen. Under the first tab, use the round SET 

button on the camera body to select Movie exposure. Select Manual. Press SET button. 

3. To set the shutter speed, turn the dial on the top of the camera body by the shutter button.  

4. To set the aperture, turn the dial on the back of the camera body around outside of the SET button. 

5. Press the ISO button on the top of the camera body. Press the selector wheel around inside of the SET button. 

6. Focus and shoot the movie (see above). 
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GUIDE: Lens Types 
EF-S 18-135mm f/3.5-5.6 IS: Covering a range from 29mm-216mm in 35mm 
format, the EF-S 18-135mm f/3.5-5.6 IS offers a combination of size, range and 
features include high-quality optics, and dedicated image stabilization.  
Best use: general photography and film production. 
Checkout: Canon 60D - Frank 

 
EF-S 18-200mm f/3.5-5.6 IS: This standard zoom lens features a wide focal 
length range from normal to telephoto equivalent to 29-320mm in the 35mm 
format. It features an Optical Image Stabilizer for up to 4-stops of effective 
correction even at full zoom.The circular aperture can give beautiful background 
blur effects.  
Best use: long range close up shots  
Checkout: Canon 60D - Tom 

 

EF 70-300mm f/4-5.6 IS USM: a telephoto zoom lens offering a broad range of 
focal lengths from a single optic, with good optical quality and excellent 
autofocus performance from its ultrasonic (USM) motor. It has a circular 
aperture diaphragm to help create natural out-of-focus highlights, and its built-in 
image stabilizer allows you to handhold the lens at shutter speeds 3 steps 
slower than would otherwise be possible. This enables sharp imaging when 
shooting at telephoto lengths and even when shooting in low light.  
Best use: long range film shots  
Checkout Canon 60D - Dean 
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EF 24-70mm f/4L IS USM: With 2 aspheric and 2 UD elements, this lens 
delivers high-quality images with excellent detail throughout the entire zoom 
range. A 9-blade circular diaphragm delivers beautiful, soft backgrounds. It 
offers a minimum focusing distance of 1.25 ft./0.38m across the entire zoom 
range and has a macro mode at the telephoto end with up to 0.7x magnification 
(minimum focusing distance becomes 7.87 in./0.2m) and is easily accessible 
with a one-touch switch.  
Best use: film production  
Checkout: Canon 5D - Mark 

 

EF 40mm f/2.8 STM: a light, inconspicuous "normal" lens. A bright f/2.8 
maximum aperture allows you to shoot under pretty much any lighting 
conditions, and the sophisticated lens configuration, including one aspherical 
element, guarantees high image quality from the center to the edge of the 
frame. The optimized coatings used in constructing the lens greatly reduce 
ghosting and flare, and deliver superb color balance.  
Best use: general wide angle photography  
Checkout: Canon 60D – Jerry or Canon 5D - Mark 

 

EF 24–105mm f/3.5–5.6 IS STM: the first Canon EF standard zoom lens for full-
frame sensor cameras to include a lead screw-type stepping motor (STM) for 
smooth and quiet AF and tracking while shooting movies or still images. It offers 
top-notch image quality thanks to two aspheric lenses and a UD lens for 
sharpness and clarity; optimized lens placement and advanced coatings that 
reduce ghosting and flare while delivering remarkable color balance; and a 7-
blade circular aperture diaphragm that creates gorgeous, soft backgrounds. 
Best use: film production moving shots  
Checkout: Canon 5D - Tony 
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EF 50mm f1/4 USM: a standard length lens featuring superb quality and 
portability. Its f/1.4 maximum aperture makes it very effective in low light 
situations and able to provide shallow depth of field focus. Two high-refraction 
lens elements and new Gaussian optics eliminate astigmatism and suppress 
astigmatic difference.  
Best use: wide angle film production  
Checkout: Canon 5D - Tony 

 

GUIDE: ISO, Shutter Speed and Aperture 
(NASIM MANSUROV http://photographylife.com/iso-shutter-speed-and-aperture-for-beginners) 

ISO – the level of sensitivity of your camera to available light. It is typically measured in numbers, a lower number 
representing lower sensitivity to available light, while higher numbers mean more sensitivity. More sensitivity comes at the 
cost though, as the ISO increases, so does the grain/noise in the images. Examples of ISO: 100, 200, 400, 800, 1600. 
Shutter Speed – the length of time a camera shutter is open to expose light into the camera sensor. Shutter 
speeds are typically measured in fractions of a second, when they are under a second. Slow shutter speeds allow more 
light into the camera sensor and are used for low-light and night photography, while fast shutter speeds help to freeze 
motion. Examples of shutter speeds: 1/15 (1/15th of a second), 1/30, 1/60, 1/125. 
Aperture – a hole within a lens, through which light travels into the camera body. The larger the hole, the more light 
passes to the camera sensor. Aperture also controls the depth of field, which is the portion of a scene that appears to be 
sharp. If the aperture is very small, the depth of field is large, while if the aperture is large, the depth of field is small. In 
photography, aperture is typically expressed in “f” numbers (also known as “focal ratio”, since the f-number is the ratio of 
the diameter of the lens aperture to the length of the lens). Examples of f-numbers are: f/1.4, f/2.0, f/2.8, f/4.0, f/5.6, f/8.0. 

GUIDE: GoPro Basic Operation 
1. Insert a Micro SD card into the camera. 
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2. Power the camera on. Press and release the Mode button (on front of 

camera). The red Status Indicator Lights flash three times and the Sound 

Indicator emits three beeps. 

3. To record Video, verify the camera is in Video mode. If the Video icon on your 

camera’s LCD screen is not showing, press the Mode button repeatedly 

until the Video icon appears.  

4. To start recording: Press and release the Shutter button (S - on top of 

camera). The camera will emit one beep and the red Status Indicator Lights will 

flash while recording.  

5. To stop recording: Press and release the Record button. The red Status Indicator Lights flash three times and 

the camera emits three beeps to indicate recording has stopped. 

GUIDE: GoPro>iPad Monitor Sync 
1. Insert a Micro SD card into the camera. 

2. Power the camera on. Press and release the Mode button (on front of camera). The red Status Indicator Lights 

flash three times and the Sound Indicator emits three beeps. 

3. Make sure that the Wi-Fi (side button) is on. Check the LCD status screen for the Wi-Fi symbol. 

4. Power the iPad on. Press the Sleep/wake button (on top) or press the Home button (on front).  

5. Swipe “slide to unlock.” 

6. Tap Settings. Tap Wi-Fi. Select the GoPro camera signal. Password is terriers. Press the iPad button. 

7. Tap the GoPro app to launch. 

8.  Tap CONNECT & CONTROL. Make sure the Video icon is visible next to the red Record button. 



20 

 

9. To record Video, tap the red Record button. To stop recording, tap the red record button a second time. 

GUIDE: iPad Movie★Slate 
1. Power the iPad on. Press the Sleep/wake button (on top) or press the 

Home button (on front).  

2. Swipe “slide to unlock.” 

3. Tap the Movie★Slate app to launch.  

4. Enter appropriate data into the available fields including: Slate, Card 

#, Scene, Take, Prod(ucer) Dir(ector), DP (Director of Photography), 

Date, Cam(era), FPS (Frames per second), F/X (Effects), INT, EXT, 

NITE, MOS (without sound). 

5. Photograph your MovieSlate by holding it up in front of the camera. 

6. Tap the clapper sticks to start a short. This will simultaneously save its data and the timecode to MovieSlate’s 

shot log history. 

7. Complete the “shot in progress mode” notes including: Shot Title, shot type note, keywords, picture rating, 

sound rating and Circle Take. When the director shouts “cut,” tap End the Shot.  
8. You may also tap False Take to restart. The Slate and Take numbers will automatically advance. 

9. When finished, tap the History icon on the bottom menu. A list of your shots will appear. Use this data when 

capturing only your best takes. 

10. You may also tap the Camera icon on the bottom menu to save specific camera information: Camera Name, Lens, 

etc. 
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GUIDE: GoPro Drone Setup 
1. Prepare the remote control. Make sure the S1 and S2 levers are switched to the upper most position. 

2. Turn the flight battery on. Press the circular button once, the press and hold for 2 seconds. 

3. Check the LED flight indicators. Slow yellow flashing indicates ready to fly. 

4. Calibrate the compass. Rapidly flip the S1 switch from “fully up “ to “fully 

down” position at least 6 times. Once the LED Flight Indicators change to 

display solid yellow, the compass calibration mode has been initiated. Hold 

the Phantom 2 horizontally, rotate 360° on its center axis until the LED 

Flight Indicators switch to solid green. Turn the Phantom 2 vertically, rotate 

360° on its center axis until the LED Flight Indicators disappear. 

ATTENTION: If the LED Flight Indicators flash yellow and red the process 

has FAILED.  

GUIDE: GoPro Drone Operation 
1. Place the Phantom 2 on the ground with the Battery Level Indicator lights 

facing you.  

2. Switch on the Remote Controller. Turn on the flight battery. 

3. Pull both sticks on the remote controller to the inside bottom corners as 

shown to start/stop the motors. 

4. Start flying! ATTENTION: ONLY stop the motors AFTER the Phantom 2 has 

landed. DO NOT stop the motors during flight. 
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5. Remote Instructions: 
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GUIDE: TASCAM Operation 
1. Move the HOLD slider on the left of the device towards the arrow. 

2. Power the TASCAM DR-40 on. Hold down the Power/Home button. 

3. Hold down the REC MODE button. 

4. Watch the REC MODE menu in the LCD screen.  

5. With REC MODE highlighted, press the right fast-forward arrow button in the 

lower wheel or control buttons to select Mono. 

6. Press the left fast forward arrow button to select REC MODE, then the minus 

button to select SOURCE. Press the right fast-forward to select either INT MIC 

MONO (top mics) or EXT IN 1 (shotgun mic plugged in to EXT MIC/LINE IN 

L). 

7. Press the HOME button.  

8. Press RECORD button once to check the audio level. Use the + INPUT 

LEVEL – button on the left side of the device to adjust the input level. 

9. Press the RECORD button a second time to begin recording (watch for the 

counter to start counting.) 

10. Press the RECORD button again to pause. Press HOME to stop recording. 

GUIDE: Advanced Room 3 Studio Operation 
SAVING BACKGROUND IMAGE AND VIDEO FILES INTO THE INTERNAL MEMORY 

1. On the Mac Pro, open the background image. Mirror Displays (⌘F1). Expand full screen. 

2. On the AG-HMX100, press the INT VIDEO button below the LCD screen. 



24 

 

3. Using the rotary 1 control, select [MEMORY]. Using the rotary 2 control, set [PAGE] (page number). 

4. Using the rotary 3 control, set [FRAME] to 1 for a still image; set to 2 or more (duration) for a video background. 

5. Press the Program (A/PROG) Shift 7(3) button to select the background image or video from the Mac Pro. 

6. Using the rotary 5 control, set [MODE] to [WRITE]. Start playback on the Mac Pro if necessary. 

7. Press the ↵ key. Press the Program (A/PROG) INT button to switch the display source to the internal file or video. 

PREVIEW THE STILL IMAGE OR VIDEO SAVED IN INTERNAL MEMORY 
1. On the AG-HMX100, press the INT VIDEO button below the LCD screen. 

2. Press the Program (A/PROG) INT button to switch the display source to the internal file or video. 

3. Set [MODE] to [PREVIEW] using the rotary 5 control. 

4. Set [PAGE] (page number) using the rotary 2 control. 

5. Set [FRAME] to the number of frames to preview using the rotary 3 control. Select 1 for a still image. 

6. To preview the still picture, select [FRAME] (frame display) or [FIELD] (field display) using the rotary 4 control. To 

preview the movie, select [REPEAT] (repeat playback) or [ONCE] (only-once playback) using the rotary 4 control. 

7. Press the ↵ key.  

8. To select the next saved image or movie, use the rotary 2 control to select the next page. Press the ↵ key. 

CHROMA KEY 
Chroma keying is a function for removing a specified color range from one image and keying another image to the range. 

1. On the AG-HMX100, press the Preset (B/PRESET) camera 1 or 2 button to select the live image. 

2. Press the CHROMA KEY button in the PATTERN area.  

1. Move the chroma key cursor (joystick) on the preview image to the color (green for example) to be removed using 

the joystick, and press the ↵ key (below CANCEL). Up to three colors (use the Rotary 2 control to switch) can be 

stored and removed from an image. To cancel a stored color, hold down SHIFT and tap any number on the keypad. 
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2. To set the chroma key in detail: 

é Set [SLICE] of the selected color in the range of 0 to 255 using the rotary 3 control.  The slice is set to specify 
the color density (saturation) in the area to be removed. For example, if you specify green using the joystick, 
the setting value can be increased to remove only green darker than the specified green. 

é Set [SLOPE] of the selected color in the range of 0 to 15 using the rotary 4 control.  The slope is set to specify 
the range (hue) of the color to be removed. For example, if you specify green using the joystick, the setting 
value can be increased to remove only green closest to the specified blue. 

é Set [K LEVEL] (transparency level of the key) in the range of 0 to 255 using the rotary 5 control. 
3. Additional adjustment can be made to [COLOR CANCEL] (color blur), [CROP], [EFFECTS], and [BORDER]. 

4. When ready, press the Program (A/PROG) INT button to set the desired background replacing the green screen. 

VIDEO PLAYBACK 
1. On the Mac Pro, open the video for playback.  

2. Mirror Displays (⌘F1). Expand full screen.  

3. Press Play (spacebar). 

4. On the AG-HMX100, press the Preset (B/PRESET) Shift 7 button to select the video image. 

5. Adjust the Left and Right audio levels with the identified sliders. 

DOWNSTREAM KEY (DSK) 
A downstream key is an image or title displayed in the foreground or your image. 

1. On the AG-HMX100, press the DSK FADE button below the LSD screen. 

2. At DSK SOURCE, use the rotary 2 control to select KEY: DVI-I. 

3. Confirm that the DSK execution button (upper right corner above the number pad) is off. 

4. Press the Program (A/PROG) Shift 7(3) button to select the image or title from the Mac Pro. 

5. Use the rotary 4 control to select the page number of memory where the title is saved. 

6. Set [MODE] to [WRITE] using the rotary 5 control, and press the ↵ key. 
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7. Press the DSK selector button (left side under –Preview–). 

8. Set the detection level of the key video by changing slice or slope setting. 

9. Set the DSK transition time (from insertion start to end) (" “To set the DSK transition time” on this page). 

10. Press the DSK execution button. The button is lighted, and flashes while the key is being inserted. 
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FOCUS: Professional Production 
(AS: 1.0, 2.1, 2.2, 2.3, .24, 2.5, 2.6, 3.1, 3.2, 3.3, 3.4, 3.5, 3.6, 3.7, 3.8, 3.9, 4.1, 4.2, 4.3, 4.4, 4.5, 4.6, 5.1, 5.2, 5.3, 5.4, 6.3, 6.4, 6.6, 7.1, 7.2, 7.3, 
7.4, 7.5, 7.6, 8.1, 8.3, 8.4, 8.5, 8.6, 8.7, 9.1, 9.2, 9.3, 9.4, 9.6, 9.7, 10.1, 10.2, 10.3, 10.4, 11.1, 11.2, 11.3, 11.4, 11.5)(PS: A1.1, A1.2, A1.3, A1.4, 
A1.6, A1.7, A1.8, A1.9, A2.1, A2.2, A2.3, A2.6, A2.7, A2.8, A2.9, A3.1, A4.2, A4.3, A4.4, A5.1, A5.2, A5.3, A5.4, A5.5, A5.6, A5.7, A7.1, A7.2, 
A7.3, A7.5, A8.1, A8.2, A8.3, A8.4, A8.5)(NETS: 1a, 1b, 1c, 1d, 2a, 2b, 2c, 2d, 3a, 3b, 4a, 4b, 4d, 5a, 5b, 5c, 5d) 

Semester grades are divided into three projects: 
é Class Production 40% 
é Personal Production 40% (including writing assignments) 
é DVD Portfolio 20% 

Finished projects will be viewed in class and critiqued based on a rubric. The creator(s) of the project must be prepared to 
discuss their own work. Grades are given by the instructor and are based on the quality and creativity of the work 
completed. Each advanced multimedia student keeps a 3-ring binder in Room 1 of his or her pre-production work, and 
written work. 
PUBLIC PRESENTATION 
In addition to regular screenings of the Friday Show online and on campus, second semester projects will be entered and 
shown at the Valley College Film Festival. Attendance of ALL Digital Dogz at ALL festivals is REQUIRED! 

PROJECTS: Class (40%) 
FRIDAY SHOW 
The Friday Show airs weekly on Terrier TV. The Friday Show is a positive reflection on the life and times of Redlands High 
School. 
TERRIER TV JOBS 
é Episode Producer/Final Cut Editor (1) 
é Segment Producer/Editor (3-4) 
é Talent/Composer (3-4) 
é Camera Operator/Animator (3-4) 
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THE TERRIER TV PRODUCTION PROCESS 
é Two production companies of 10 to 13 students have two weeks each to produce a 10 minute Friday Show. 
é Each company includes 1 Episode Producer/Editor, and at least 3 Segment Producers/Editors, 3 Talent/Composers, 

and 3 Camera Operator/Animators. 
é Each Episode Producer/Final Cut Editor is responsible for creating, editing, and delivering one 10 minute Friday 

Show every other week. In addition, they are responsible for a 30 second intro, and 30 second outro for each 
episode. 

é Each Segment Producer/Editor is responsible for creating, editing, and publishing a webpage to RHX one 2 to 3 
minute segment every other week. 

é Each Talent/Composer is responsible for writing a script, performing in, and scoring one 2 to 3 minute segment 
every other week. In addition they write a brief description of the segment for RHX. 

é Each Camera Operator/Animator is responsible for storyboarding, shooting, editing, and adding animation (to 
either part of the segment or the whole segment). 

THEMED EPISODES 
Episodes should revolve around a common theme. Some weeks are easy: Homecoming, Halloween, Spring Break, Prom. 
Some weeks will be more challenging. The week’s theme should act as a thread that travels through each segment 
including the intro, the outro and the website tying it all together. 
SEGMENTS 
Each week’s episode will include 3 to 4 segments. Some segments will appear more often than others. New episode 
ideas are always welcome. Examples of weekly Friday Show 2-3 minute segments include: 
é Student Life 
é Teacher Biography 
é Club Profile 
é ASB 
é Sports 
é Special Events 
é Freetime  
é Cartoon 
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EXAMPLE: Student life 
Everyone wants to be more successful. People like Walt Disney and Steve Jobs were regular people, but with something 
most people don’t have, monster success. How did they achieve this success? What makes them so successful? 
Inquiring minds want to know. People are fascinated with other peoples’ lives, and love watching them on TV. Now is your 
chance to present a successful person here at RHS. Choose a student at RHS who has achieved great success (ex. an 
athlete, academic, artist, ASB member, or any other), but who is not necessarily the most popular, or most known student 
on campus. Paint a portrait of this student’s life at RHS by interviewing them on camera, and following them around 
through their day. Combine the best interviewing techniques as used by Barbara Walters, and the best human-interest 
techniques as used by Biography. What is interesting about this student? What makes them stand out? To whom or what 
do they owe their success? What are their future plans? What is their day like? Who do they hangout with? What do they 
like to do for fun? And so on. 
BASIC SEGMENT ELEMENTS 
é Cutaway shots 
é Soundtrack (25% volume under dialogue) 
é Voice Over 
é Lower 3rd Titles 
é Steady camera work 
é Always white balance camera 

FESTIVAL 
At the end of the fall semester, a handful of original 5-page scripts will be selected by the Digital Dogz to be produced and 
submitted to the Valley Film Festival in the spring. Students will sign up for a script of their choice and assist in its 
production working in small groups. All the rules of pre-production, production, and postproduction apply. 
Cast actors from your group, the Drama Department, or other people on campus. Scout the perfect locations on-campus 
to use for shooting. Focus on the art direction, making the story as believable as possible. Choose a script with a 
message, find a target audience, and design your production with the goal of communicating directly to those people. 
Keep projects no longer than 5 minutes in length. 
CLIENT PROJECTS 
The art of documentary includes both education and entertainment. The goal is to create a finished project that is both 
informative and interesting. Conduct research and present it in an entertaining way. Engage the viewer with fascinating 
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facts and stories on a topic related to the community. Use the elements of art to express mood. Students must produce a 
video research project about an element of their community. The DVD Documentary Team are responsible for their own 
work schedule and deadlines. 

PROJECTS: Personal (40%) 
MOTION 5 
Create brilliant titles, transitions, effects, and more with Motion 5, the motion graphics companion to Final Cut Pro X. This 
hands-on course starts with motion graphics fundamentals and moves into compositing, animation, and the world of 3D. 
Explore new intelligent templates to quickly and flexibly create high-quality effects, titles, transitions, and generators as 
well as create rigs to adjust related parameters with a single control. 
Multiple project tasks are completed. Chapter tests are given at the end of each chapter. When the students feel ready, 
they can take the Motion 5 Exam for certification in Motion 5. 
STUDENTS WILL LEARN 
é Creating Smart Motion Templates and publishing them to Final Cut Pro X. 
é Creating parameter rigs to quickly adjust related parameters with a single control. 
é Understanding behavior-based animation. 
é Using keyframes to create animation. 
é Creating content with Generators, shapes and paint strokes. 
é Stabilizing and tracking media. 
é Animating cameras and using advanced 3D features. Quizzes and final 

An online quiz will be given for each lesson. Quizzes must be taken in Room 1 during class. Students may not take a quiz 
with their textbook open, or with Motion 5 open on the computer (or any other computer around them). Students may not 
copy and paste or write down the correct answers while taking the quiz. If a student is dissatisfied with his or her quiz 
score, they may review their study materials and retake the quiz one time in class only. Quiz scores are calculated into the 
students’ semester grade. 
A Motion 5 final exam is administered on the day of the first semester final. 
PLACEHOLDER EDIT 
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As a last step in the preproduction process, every student (whether their script is produced or not) creates a storyboard 
animation in Final Cut Pro X.  

1. Using GarageBand, record yourself reading your 5-page script out loud. Include all of the scene headings, action, 

character cures, dialogue, and transitions. This will also estimate the running time of the finished project. 

2. Share the recording to Final Cut Pro X. Add to the primary storyline in the magnetic timeline. 

3. Add specific placeholders to the primary storyline reflecting the different shots for each scene. 

4. Describe each scene and shot in the text field for each placeholder (i.e. Scene 1 Shot 

1, etc.) 

5. Export as a QuickTime movie. Use the Placeholder Edit to guide the production 

process.  

WRITING 
Students must complete all of the following written assignments. 
é Production Journal (see details in Advanced Multimedia) 
é Production Reports (see details in Advanced Multimedia) 

PROJECT: Portfolio Update (20%) 
In Multimedia Design CP you created a DVD Portfolio. Now it is time for you to create a new DVD portfolio with your work 
from Advanced Multimedia. All the work on this project must be your own original work! 
PART A: WRITTEN AND SPOKEN COMMENTARY OF PROJECT 

1. Choose your three (3) favorite segments or episodes or projects that you worked on this semester. Answer the 

following for each project in a narrative: 

2. What was your original idea? 

3. What is the specific meaning of the project to you? 

4. Describe the complete production process you used. 
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5. Describe how you used the elements of Art to express mood. 

6. What were some of your personal favorites about the project? 

7. Post your written response on each individual movie submenu.  

8. Record commentary for this project and add it to your video project using Final Cut Pro X or GarageBand.  

9. Include links on your movie submenu to both versions of your video project: one with commentary, and one without. 

PART B: DVD UPDATE 
1. Create a still images or animation to use as submenu buttons for each project. 

2. Open your login_portfolio project folder from your documents.  

3. Create a new folder called “adv_media” in your login_portfolio folder.  

4. Move your selected advanced projects into the “adv_media” folder.  

5. Open your portfolio in iDVD.  

6. Go to the Advanced Menu. 

7. Create three submenu buttons and place the appropriate still image or animation in these submenu buttons. 

8. Open the first submenu. Add an appropriate background and soundtrack for this submenu. 

9.  Place both the regular and commentary segment or episode .mov files on this submenu.  

10. Repeat steps 8 through 10 for the other two segments or episodes you selected. 

11. Update your Profile Webpages and Video as well as text Resume. 

PART C: ARCHIVE PROJECT 
Creating an archive of your DVD Portfolio will allow you to add more work to it at a later date. 

12. In iDVD, go to File>Archive Project… 

13. In the dialogue box that appears type at:  

14. Save As: login_dvd Archived 
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15. Where: login_portfolio 

16. Check: Include themes 

17. Check: Include encoded files 

18. Click the Save button. 

PART D: ADD DVD-ROM CONTENT 
1. In iDVD go to Advanced > Edit DVD-ROM Contents… 

2. In the DVD-ROM dialogue box select Add Files… 

3. Navigate to your login_portfolio folder in your documents folder and select your login_resume file. Click Open. 

4. Select Add Files… again. Now select your first semester web portfolio. Click Open. 

5. Select Add Files… again. Now select your DVD Box Sleeve and Disc Label files. Click Open. 

6. Select Add Files… again. Now select your login_dvd Archive. Click Open. 

7. Now add any other files you want to include in the read only portion on the DVD. 

PART E: SAVE AS DISK IMAGE 
THE DISC IMAGE PROCESS WILL TAKE THE MAJORITY OF THE PERIOD! PLEASE BEGIN THIS PROCESS AT THE 
BEGINNING OF YOUR CLASS PERIOD!!! CREATE A DISK IMAGE BEFORE PART H: BURN DISC. 

1. Budget 20-30 minutes to save your disk image. 

2. Launch iDVD. 

3. Go to Project>Project Info (⌘I). 

4. Confirm at Disc Name that you typed: login_portolio 

5. Confirm that Encoding: is set to High Quality. 

6. Check to make sure that there are no red bars visible.  

7. If your DVD Capacity is too full, you must delete some files from your DVD-ROM contents. 
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8. If your Motion Menus are too long, you must go back to each menu and shorten the Loop Duration. 

9. When you are finished, and you have completed the grading rubric check sheet you may save your disc image. 

10. Go to File>Save as Disc Image…(ñ⌘R) 

11. At Save Disc Image As… 

12. Save As: login_portfolio 

13. Where: Desktop 

14. Click Save. 

15. Double click the .img file to open the disc image. Launch DVD Player to test your project. 

16. When finished, drag the login_portfolio.img file drag to the hand-in folder and submit your score sheet. 

17. OPTIONAL: Plug A usb drive into the computer and drag your login_portfolio.img file onto your drive. 

PART F: BURN DISC (OPTIONAL) 
THE BURN PROCESS WILL TAKE THE MAJORITY OF THE PERIOD! PLEASE COMPLETE PART G FIRST!! PLEASE 
BEGIN THIS PROCESS AT THE BEGINNING OF YOUR CLASS PERIOD!!!  

1. Quit iDVD. 

2. Launch Disk Utility from the Applications>Utilities folder. 

3. Drag your login_portfolio.img file from the desktop into the rectangular window on the left below SuperDrive. 

4. Click on the login_portfolio.img title in Disk Utility to select it. Then click the Burn button in the top tool bar. 

5. Write your name and the date on your DVD-R and insert it into the optical drive slot on the right side of the 

computer. 

6. Click Burn. 

7. When the disk is finished it will pop back out of the optical drive slot.  

8. Remove your DVD disk and take it home.
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FOCUS: Screenwriting 
(AS 1.0, 2.1, 2.2, 2.3, 2.4, 2.5, 3.2, 3.6, 4.1, 4.2, 4.3, 5.1, 5.2, 5.3, 6.6, 7.4, 8.3, 8.6, 9.2, 9.3, 10.3, 10.4, 11.4)(PS A1.1, A1.4, A1.5, A1.6, A2.1, 
A2.2, A3.2, A3.3, A3.6, A4.3, A4.6, A5.1, A5.3, A5.5, A6.1, A6.2, A7.1, A7.2, A7.3, A7.5, A8.1, A8.2, A8.4, A8.5)(NETS 1a, 1b, 2a, 2b, 3a, 4a, 4b, 
5a, 5b, 5c, 6b) 

Weekly Schedule: 
é Monday: Film History 
é Tuesday: Story by Robert McKee 
é Wednesday/Thursday: Script Reading/Writing 
é Friday: Film Critiques 

PROJECT: 22 page Short Screenplay (50%) 
Each student will write his or her own screenplay using Final Draft. 
The writing process will include a pitch, character structure, step outline, treatment, first draft, peer draft, final draft, 
and query letter. 
Each screenplay story must include: 
é Protagonist (hero or main character) 
é Antagonist (villain or opposing force) 
é Plot (story to tell) including a beginning, middle, and end. 

Each plot must include 5 parts: 
1. Inciting Incident (radical upset to the balance of forces in the protagonist’s life) p. 189 

2. Progressive Complications (rising action) p. 208 

3. Crisis (quest) p. 303 

4. Climax (success or failure) p. 309 
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5. Resolution (falling action) p. 312 

Consider writing an episode to one of the following TV templates available in Final Draft 9: 
é Arrested Development 
é Community 
é Covert Affairs 
é Criminal Minds 
é Elementary 
é Family Guy 

é Grey’s Anatomy 
é Mad Men 
é Modern Family 
é NCIS 
é New Girl 
é Parks and Recreation 

é Pretty Little Liars 
é Sons of Anarchy 
é South Park 
é The Simpsons 
é Two and a Half Men 
é Workaholics

THE WRITING PROCESS 
Checkout the Final Draft tutorial here: http://www.finaldrafttutorial.com 
PITCH 
Write a one-paragraph synopsis of the idea. Include the main character(s), their goal(s), and the obstacle(s) to 
achieving their goal(s). Keep it simple! 
CHARACTER STRUCTURE 
Complete one character structure worksheet for each major character in your story. 
STEP-OUTLINE 
A step-outline is the story told in steps. Use index cards to write your step-outline (Story p. 412-416). Write a short 
description of each scene, using one or two sentence statements, simply describe what happens in each scene, how it 
builds, and turns. On the backside of each card, number the scene and indicate what step in the design of the story the 
scene fulfills. 
TREATMENT 
Expand the step-outline to a full-page, double-spaced, 12-point font, present tense, moment-by-moment narrative 
description. Do not include dialogue, only subtext: the true thoughts and feelings underneath what is said and done. 
FIRST/PEER/FINAL DRAFT 
é Submit the FIRST draft of your script by the end of the 8th week of class. 
é Share your second draft with a student in class and exchange notes by the end of the 13th week of class. 
é Submit the FINAL draft of your script by the end of the 17th week of class.  
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QUERY LETTER (EMAIL) AND FESTIVAL SUBMISSION 
Using the Final Draft 9 Query Letter template, write a query letter to email to the production company who makes the 
show of the script you wrote. Send the email and see if they respond! 
Submit your short screenplay to any student film festival – you might just win!! 

GUIDE: Screenwriting Conventions 
é Avoid “On the Nose” Dialogue (use subtext). 
é Capitalize main character’s names and add an age 

range when they are introduced. 
é Do not add camera cues of any kind. 
é Join the scene late; then leave early. 
é Include either Day or Night at the end of scene 

headings. 

é Show, Don’t Tell. 
é Split action into 2-4 line chunks. 
é Use dashes (-) in place of ellipses (…). 
é Write action in present tense. 
é Write dialogue like people actually talk. 
é Write parenthetical instructions only when absolutely 

necessary. 

GUIDE: McKee’s Film Genres 
1. Love Story 
2. Horror Film 
3. Modern Epic 
4. Western 
5. War Genre 
6. Maturation Plot 
7. Redemption Plot 
8. Punitive Plot 
9. Testing Plot 

10. Education Plot 
11. Disillusionment Plot 
12. Comedy 
13. Crime 
14. Social Drama 
15. Action/Adventure 
16. Historical Drama 
17. Biography 
18. Docu-Drama 

19. Mockumentary 
20. Musical 
21. Science Fiction 
22. Sports Genre 
23. Fantasy 
24. Animation 
25. Art Film 

 

GUIDE: Final Draft Peer Revisions 
1. Place a copy of your screenplay.fdx file in the Second Drafts folder on the server. 
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2. Choose another student’s screenplay.fdx file and move it to your desktop. Move the same file from the Second 

Drafts folder to the trash (⌘ delete) so that it does not get selected twice. 

3. Open the other student’s screenplay.fdx file in Final Draft. 

4. File>Save As… (ñ⌘S) Rename at Save As: title_login_notes. Use their original title plus your login name. 

5. Production>Revisions… Check the box next to Revision Mode.  

6. At Edit revision set labels: type in login_notes. Use your login name. 

7. At Revised text appearance: click on the color swatch next to Color: and select a new color (if desired). Click Ok. 

8. Click the Flag Icon in the upper right corner to launch the ScriptNotes Navigator. 

9. Read through the screenplay. Place the cursor where you wish to make a note and click the Flag+ icon in the 

ScriptNotes Navigator (⌘=). Add a title in the Name: window. Add you notes in the Note Text window. To delete 

a note click on the red X in the ScriptNotes Navigator. You may also make changes directly to the script. Changes 

will appear in whatever color you selected in Revised text appearance. 

10. Save when finished. Place this copy in the Returned Second Drafts folder on the server. 

GUIDE: Final Draft Revision Mode 
Once you receive notes on a Final Draft (.fdx) file, follow these instructions to make appropriate changes. 

1. Open the .fdx file in Final Draft. 

2. To turn off Revision Mode, go to Production>Revision Mode (check mark should go away). 

3. Click the Flag Icon in the upper right corner to launch the ScriptNotes Navigator. 

4. After you read and address a note, click on the red X in the ScriptNotes Navigator to delete it. 

5. To clear other revisions in the screenplay, highlight, then go to Production>Clear Revised or (⌘[). 

6. When finished, rename and save the new revised version. 
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PROJECT: Script Reviews (20%) 
Students will read 4 feature film scripts during the semester and write script 
reviews. Script reviews include: 
é Author 
é Title 
é Logline 
é Genre 
é Setting 
é Protagonist 
é Antagonist 
é Plot (including Inciting Incident) 
é Script Review Score (see box at right) 
é What You Learned 
Check the SchoolFusion page for script sources. 

PROJECT: Film History (15%) 
Students will watch the documentary series The Story of Film: An Odyssey (2011) and respond to assigned questions. 
This 15-episode documentary is directed and narrated by Mark Cousins, adapted from his 2004 book The Story of Film 
and chronicling more than 100 years of world film history. 

PROJECT: Film Critiques (15%) 
Students will participate in a teacher directed online discussion of the movies watched in class. Movies may include: 
é The Birds (1963) - PG-13 
é Casablanca (1942) - PG 
é Chinatown (1974) - R 
é Citizen Kane (1941) - PG 
é The Dark Knight (2008) - PG-13 
é The Godfather (1972) - R 
é Jaws (1975) - PG 

é Life of Pi (2012) - PG 
é North by Northwest (1959) - not rated 
é Psycho (1960) - PG-13 
é Rear Window (1954) - PG 
é Singin’ in the Rain (1952) - G 
é Star Wars: Episode IV - A New Hope (1977) - PG 
é Vertigo (1958) - PG 

Script Review Score: 
[ ] what the heck did I just read?   
[ ] wasn’t for me   
[ ] worth the read   
[ ] impressive   
[ ] genius 
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SUPPLEMENTAL READING 
Brenneis, Lisa, Final Cut Pro for Macintosh, Peachpit Press, 2000. 
DiNucci, Darcy, Maria Giudice, Lynne Stiles, Elements of Web Design, 2nd. Edition, Peachpit Press, 1998. 
Foster, Jeff, The PhotoShop Web Magic, Volume 2, Hayden Books, 1997. 
GarageBand: Getting Started. Apple Computer, Inc., 2006 
Hoffer, Avi. Digital Guerrilla Video. Miller Freeman Books, 1999. 
Jones, Fredric, Desktop Digital Video Production. Prentice Hall Press Multimedia Series. 1999. 
McKee, Robert. Story. HarperCollins, 1997 
Musburger, Robert. Single Camera Video Production. Focal Press, 1999. 
The PhotoShop Rocks Saturday and Sunday Workbooks, Nation Association of Pixelmator Professionals, 2001 
Production Handbook, New York University, 2000.  
Ragans, Rosaline, Art Talk, Glencoe/McGraw-Hill, 1995. 
Spencer, Mark, Motion 5, Designing and Animating Motion Graphics, Peachpit Press, 2012. 
Weynand, Diana, Final Cut Pro 6, Peachpit Press, 2007. 
Weynand, Diana, Final Cut Pro X, Second Edition, Peachpit Press, 2012. 
Wohl, Michael, Editing Techniques with Final Cut Pro, Peachpit Press, 2002. 
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ARTS, MEDIA, AND ENTERTAINMENT KNOWLEDGE AND PERFORMANCE ANCHOR STANDARDS (AS) 
(http://www.cde.ca.gov/ci/ct/sf/documents/artsmedia.pdf) 

1.0 ACADEMICS 
Analyze and apply appropriate academic standards required for successful industry sector pathway completion leading to 
postsecondary education and employment.  
2.0 COMMUNICATIONS 
Acquire and accurately use Arts, Media, and Entertainment sector terminology and protocols at the career and college 
readiness level for communicating effectively in oral, written, and multimedia formats. (Direct alignment with the English 
Language Arts Standards 9-10, 11-12.6) 

2.1 Recognize the elements of communication using a sender–receiver model. 
2.2 Identify barriers to accurate and appropriate communication. 
2.3 Interpret verbal and nonverbal communications and respond appropriately. 
2.4 Demonstrate elements of written and electronic communication such as accurate spelling, grammar, and format. 
2.5 Communicate information and ideas effectively to multiple audiences using a variety of media and formats. 
2.6 Advocate and practice safe, legal, and responsible use of digital media information and communications 

technologies. 
3.0 CAREER PLANNING AND MANAGEMENT 
Integrate multiple sources of career information from diverse formats to make informed career decisions, solve problems, 
and manage personal career plans. (Direct alignment with the English Language Arts Listening and Speaking 
Standards 11-12.2) 

3.1 Identify personal interests, aptitudes, information, and skills necessary for informed career decision making. 
3.2 Evaluate personal character traits such as trust, respect, and responsibility and understand the impact they can 

have on career success. 
3.3 Explore how information and communication technologies are used in career planning and decision making. 
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3.4 Research the scope of career opportunities available and the requirements for education, training, certification, and 
licensure. 

3.5 Integrate changing employment trends, societal needs, and economic conditions into career planning. 
3.6 Recognize the role and function of professional organizations, industry associations, and organized labor in a 

productive society. 
3.7 Recognize the importance of small business in the California and global economies. 
3.8 Understand how digital media are used by potential employers and postsecondary agencies to evaluate 

candidates. 
3.9 Develop a career plan that reflects career interests, pathways, and postsecondary options. 
4.0 TECHNOLOGY 
Use existing and emerging technology to investigate, research, and produce products and services, including new 
information, as required in the Arts, Media, and Entertainment sector workplace environment. (Direct alignment with the 
English Language Arts Writing Standards 11-12.6) 

4.1 Use electronic reference materials to gather information and produce products and services. 
4.2 Employ Web-based communications responsibly and effectively to explore complex systems and issues. 
4.3 Use information and communication technologies to synthesize, summarize, compare, and contrast information 

from multiple sources. 
4.4 Discern the quality and value of information collected using digital technologies, and recognize bias and intent of 

the associated sources. 
4.5 Research past, present, and projected technological advances as they impact a particular pathway. 
4.6 Assess the value of various information and communication technologies to interact with constituent populations as 

part of a search of the current literature or in relation to the information task. 
5.0 PROBLEM SOLVING AND CRITICAL THINKING 
Conduct short as well as more sustained research to create alternative solutions to answer a question or solve a problem 
unique to the Arts, Media, and Entertainment sector, using critical and creative thinking, logical reasoning, analysis, 
inquiry, and problem-solving techniques. (Direct alignment with the English Language Arts Writing Standards 11-12.7) 
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5.1 Identify and ask significant questions that clarify various points of view to solve problems. 
5.2 Solve predictable and unpredictable work-related problems using various types of reasoning (inductive, deductive) 

as appropriate. 
5.3 Use systems thinking to analyze how various components interact with each other to produce outcomes in a 

complex work environment. 
5.4 Interpret information and draw conclusions, based on the best analysis, to make informed decisions. 
6.0 HEALTH AND SAFETY 
Demonstrate health and safety procedures, regulations, and personal health practices and determine the meaning of 
symbols, key terms, and domain-specific words and phrases as related to the Arts, Media, and Entertainment sector 
workplace environment. (Direct alignment with the English Language Arts Science and Technical Subjects 
Standards 9-10, 11-12.4) 

6.1 Locate, and adhere to, Material Safety Data Sheet (MSDS) instructions. 
6.2 Interpret policies, procedures, and regulations for the workplace environment, including employer and employee 

responsibilities. 
6.3 Use health and safety practices for storing, cleaning, and maintaining tools, equipment, and supplies. 
6.4 Practice personal safety when lifting, bending, or moving equipment and supplies. 
6.5 Demonstrate how to prevent and respond to work-related accidents or injuries; this includes demonstrating an 

understanding of ergonomics. 
6.6 Maintain a safe and healthful working environment. 
6.7 Be informed of laws/acts pertaining to the Occupational Safety and Health Administration (OSHA). 
7.0 RESPONSIBILITY AND FLEXIBILITY 
Initiate, and participate in, a range of collaborations demonstrating behaviors that reflect personal and professional 
responsibility, flexibility, and respect in the Arts, Media, and Entertainment sector workplace environment and community 
settings. (Direct alignment with the English Language Arts Speaking and Listening Standards 9-10, 11-12.1) 

7.1 Recognize how financial management impacts the economy, workforce, and community. 
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7.2 Explain the importance of accountability and responsibility in fulfilling personal, community, and workplace roles. 
7.3 Understand the need to adapt to changing and varied roles and responsibilities. 
7.4 Practice time management and efficiency to fulfill responsibilities. 
7.5 Apply high-quality techniques to product or presentation design and development. 
7.6 Demonstrate knowledge and practice of responsible financial management. 
7.7 Demonstrate the qualities and behaviors that constitute a positive and professional work demeanor, including 

appropriate attire for the profession. 
7.8 Explore issues of global significance and document the impact on the Arts, Media, and Entertainment sector. 
8.0 ETHICS AND LEGAL RESPONSIBILITIES 
Practice professional, ethical, and legal behavior, responding thoughtfully to diverse perspectives and resolving 
contradictions when possible, consistent with applicable laws, regulations, and organizational norms. (Direct alignment 
with the English Language Arts Standards Speaking and Listening Standards 11-12.1d) 

8.1 Access, analyze, and implement quality assurance standards of practice. 
8.2 Identify local, district, state, and federal regulatory agencies, entities, laws, and regulations related to the Arts, 

Media, and Entertainment industry sector. 
8.3 Demonstrate ethical and legal practices consistent with Arts, Media, and Entertainment sector workplace 

standards. 
8.4 Explain the importance of personal integrity, confidentiality, and ethical behavior in the workplace. 
8.5 Analyze organizational culture and practices within the workplace environment. 
8.6 Adhere to copyright and intellectual property laws and regulations, and use and appropriately cite proprietary 

information. 
8.7 Conform to rules and regulations regarding sharing of confidential information, as determined by Arts, Media, and 

Entertainment sector laws and practices. 
9.0 LEADERSHIP AND TEAMWORK 
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Work with peers to promote divergent and creative perspectives, effective leadership, group dynamics, team and 
individual decision making, benefits of workforce diversity, and conflict resolution as practiced in the SkillsUSA career 
technical student organizations. (Direct alignment with the English Language Arts Speaking and Listening Standards 
11-12.1b) 

9.1 Define leadership and identify the responsibilities, competencies, and behaviors of successful leaders. 
9.2 Identify the characteristics of successful teams, including leadership, cooperation, collaboration, and effective 

decision-making skills as applied in groups, teams, and career technical student organization activities. 
9.3 Understand the characteristics and benefits of teamwork, leadership, and citizenship in the school, community, and 

workplace setting. 
9.4 Explain how professional associations and organizations and associated leadership development and competitive 

career development activities enhance academic preparation, promote career choices, and contribute to 
employment opportunities. 

9.5 Understand that the modern world is an international community and requires an expanded global view. 
9.6 Respect individual and cultural differences and recognize the importance of diversity in the workplace.  
9.7 Participate in interactive teamwork to solve real Arts, Media, and Entertainment sector issues and problems. 
10.0 TECHNICAL KNOWLEDGE AND SKILLS 
Apply essential technical knowledge and skills common to all pathways in the Arts, Media, and Entertainment sector, 
following procedures when carrying out experiments or performing technical tasks. (Direct alignment with the English 
Language Arts Writing Standards 11-12.6) 

10.1 Interpret and explain terminology and practices specific to the Arts, Media, and Entertainment sector. 
10.2 Comply with the rules, regulations, and expectations of all aspects of the Arts, Media, and Entertainment sector. 
10.3 Construct projects and products specific to the Arts, Media, and Entertainment sector requirements and 

expectations. 
10.4 Collaborate with industry experts for specific technical knowledge and skills. 
11.0 DEMONSTRATION AND APPLICATION 
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Demonstrate and apply the knowledge and skills contained in the Arts, Media, and Entertainment anchor standards, 
pathway standards, and performance indicators in classroom, laboratory, and workplace settings, and through the 
SkillsUSA career technical student organizations. 
11.1 Utilize work-based/workplace learning experiences to demonstrate and expand upon knowledge and skills gained 

during classroom instruction and laboratory practices specific to the Arts, Media, and Entertainment sector program 
of study. 

11.2 Demonstrate proficiency in a career technical pathway that leads to certification, licensure, and/or continued 
learning at the postsecondary level. 

11.3 Demonstrate entrepreneurship skills and knowledge of self-employment options and innovative ventures. 
11.4 Employ entrepreneurial practices and behaviors appropriate to Arts, Media, and Entertainment sector opportunities. 
11.5 Create a portfolio, or similar collection of work, that offers evidence through assessment and evaluation of skills 

and knowledge competency as contained in the anchor standards, pathway standards, and performance indicators. 
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ARTS, MEDIA, AND ENTERTAINMENT PATHWAY STANDARDS (PS) 
(http://www.cde.ca.gov/ci/ct/sf/documents/artsmedia.pdf) 

The Design, Visual, and Media Arts pathway includes those occupations that use visual art, digital media, and Web-based 
tools and materials as the primary means of communication and expression. In addition to an understanding of current 
workplace practice, this career pathway requires the development of knowledge and skills in both visual art concepts as 
well as new and emerging digital processes by which individuals are able to create and communicate complex concepts in 
a broad range of occupations and professions. 
A1 DEMONSTRATE ABILITY TO REORGANIZE AND INTEGRATE VISUAL ART ELEMENTS ACROSS DIGITAL 
MEDIA AND DESIGN APPLICATIONS. 
A1.1 View and respond to a variety of industry-related artistic products integrating industry appropriate vocabulary. 
A1.2 Identify and use the principles of design to discuss, analyze, and create projects and products across multiple 

industry applications. 
A1.3 Describe the use of the elements of art to express mood in digital or traditional art work found in the commercial 

environment. 
A1.4 Select industry-specific works and analyze the intent of the work and the appropriate use of media.  
A1.5 Research and analyze the work of an artist or designer and how the artist’s distinctive style contributes to their 

industry production.  
A1.6 Compare and analyze art work done using electronic media with those done with materials traditionally used in the 

visual arts.  
A1.7 Analyze and discuss complex ideas, such as distortion, color theory, arbitrary color, scale, expressive content, and 

real versus virtual in works of art.  
A1.8 Compare how distortion is used in a variety of media to modify the message being communicated.  
A1.9 Analyze the material used by a given artist and describe how its use influences the meaning of the work.  
A2 APPLY ARTISTIC SKILLS AND PROCESSES TO SOLVE A VARIETY OF INDUSTRY-RELEVANT PROBLEMS 
IN A VARIETY OF TRADITIONAL AND ELECTRONIC MEDIA.  
A2.1 Demonstrate skill in the manipulation of digital imagery (either still or video) in an industry-relevant application.  
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A2.2 Demonstrate personal style and advanced proficiency in communicating an idea, theme, or emotion in an industry-
relevant artistic product.  

A2.3 Apply refined observation and drawing skills to solve an industry-relevant problem.  
A2.4 Use visual metaphors in creating an artistic product.  
A2.5 Compile a portfolio of multiple original two- and three-dimensional works of art that reflect technical skills in an 

industry-relevant application.  
A2.6 Create an artistic product that involves the effective use of the elements of art and the principles of design.  
A2.7 Create original works of art of increasing complexity and skill in a variety of media that reflect their feelings and 

points of view.  
A2.8 Plan and create artistic products that reflect complex ideas, such as distortion, color theory, arbitrary color, scale, 

expressive content, and real versus virtual.  
A2.9 Create a multimedia work of art that demonstrates knowledge of media and technology skills.  
A3 ANALYZE AND ASSESS THE IMPACT OF HISTORY AND CULTURE ON THE DEVELOPMENT OF 
PROFESSIONAL ARTS AND MEDIA PRODUCTS.  
A3.1 Identify and describe the role and influence of new technologies on contemporary arts industry.  
A3.2 Describe how the issues of time, place, and cultural influence and are reflected in a variety of artistic products.  
A3.3 Identify contemporary styles and discuss the diverse social, economic, and political developments reflected in art 

work in an industry setting.  
A3.4 Identify art in international industry and discuss ways in which the work reflects cultural perspective. 
A3.5 Analyze similarities and differences of purpose in art created in culturally diverse industry applications. 
A3.6 Investigate and discuss universal concepts expressed in visual media products from diverse cultures.  
A4 ANALYZE, ASSESS AND IDENTIFY EFFECTIVENESS OF ARTISTIC PRODUCTS BASED ON ELEMENTS OF 
ART, THE PRINCIPLES OF DESIGN, AND PROFESSIONAL INDUSTRY STANDARDS. 
A4.1 Develop written consumer assessment rubrics for separate, industry-specific art products. 
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A4.2 Deconstruct how beliefs, cultural traditions, and current social, economic, and political contexts influence 
commercial media (traditional and electronic).  

A4.3 Analyze the aesthetic value of a specific commercial work of art and defend that analysis from an industry 
perspective.  

A4.4 Analyze the relationship between the artist, artistic product and audience in both an existing and self-generated 
project. 

A4.5 Analyze and articulate how society influences the interpretation and effectiveness of an artistic product.  
A4.6 Create an artistic product for a specific industry and modify that product to accommodate a different aesthetic 

perspective.  
A5 IDENTIFY ESSENTIAL INDUSTRY COMPETENCIES, EXPLORE COMMERCIAL APPLICATIONS AND 
DEVELOP A CAREER SPECIFIC PERSONAL PLAN. 
A5.1 Compare and contrast the ways in which different artistic media (television, newspapers, magazines, and electronic 
media) cover the same commercial content.  
A5.2 Explore the role of art and design across various industry sectors and content areas. 
A5.3 Deconstruct works of art, identifying psychological content found in the symbols and images and their relationship 

to industry and society.  
A5.4 Predict how changes in technology might change the role and function of the visual arts in the workplace.  
A5.5 Create a commercial artistic product that communicates a cross-cultural or universal theme.  
A5.6 Prepare portfolios of original art created for a variety of purposes and commercial applications.  
A5.7 Synthesize traditional art work and new technologies to design an artistic product to be used by a specific industry. 
A6 ANALYZE CHARACTERISTICS OF SUBGENRES (E.G., SATIRE, PARODY, ALLEGORY, PASTORAL) THAT 
ARE USED IN POETRY, PROSE, PLAYS, NOVELS, SHORT STORIES, ESSAYS, AND OTHER BASIC GENRES. 
A6.1 Evaluate the ways in which irony, tone, mood, the author’s style, and the “sound” of language achieve specific 

rhetorical or aesthetic purposes or both. 
A6.2 Analyze the way in which authors through the centuries have used archetypes drawn from myth and tradition in 

literature, film, political speeches, and religious writings. 
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A6.3 Debate the philosophical arguments presented in literary works to determine whether the authors’ positions have 
contributed to the quality of each work and the credibility of the characters (philosophical approach). 

A7 DEMONSTRATE AN UNDERSTANDING OF THE ELEMENTS OF DISCOURSE (E.G., PURPOSE, SPEAKER, 
AUDIENCE, FORM) WHEN COMPLETING NARRATIVE, EXPOSITORY, PERSUASIVE, OR DESCRIPTIVE WRITING 
ASSIGNMENTS. 
A7.1 Use point of view, characterization, style (e.g., use of irony), and related elements for specific rhetorical and 

aesthetic purposes. 
A7.2 Use language in natural, fresh, and vivid ways to establish a specific tone. 
A7.3 Enhance meaning by employing rhetorical devices, including extended use of parallelism, repetition, analogy; 

incorporation of visual aids (e.g., graphs, tables, pictures); and the issuance of a call for action. 
A7.4 Integrate databases, graphics, and spreadsheets into electronically-processed documents. 
A7.5 Revise text to highlight the individual voice, improve sentence variety and style, and enhance subtlety of meaning 

and tone in ways that are consistent with the purpose, audience, and genre. 
A8 UNDERSTAND THE KEY TECHNICAL AND TECHNOLOGICAL REQUIREMENTS APPLICABLE TO VARIOUS 
SEGMENTS OF THE MEDIA AND DESIGN ARTS PATHWAY. 
A8.1 Understand the component steps and skills required to design, edit, and produce a production for audio, video, 

electronic, or printed presentation.  
A8.2 Use technology to create a variety of audio, visual, written, and electronic products and presentations.  
A8.3 Know the features and uses of current and emerging technology related to computing (e.g., optical character 

recognition, sound processing, cable TV, cellular phones).  
A8.4 Analyze the way in which technical design (e.g., color theory, lighting, graphics, typography, posters, sound, 

costumes, makeup) contributes to an artistic product, performance, or presentation.  
A8.5 Differentiate writing processes, formats, and conventions used for various media. 
A8.6 Analyze and assess technical support options related to various media and design arts.  
A8.7 Evaluate how advanced and emerging technologies (e.g., virtual environment or voice recognition software) affect 

or improve media and design arts products or productions.  



51 

 

NATIONAL EDUCATIONAL TECHNOLOGY STANDARDS FOR STUDENTS (NETS) 
 “What students should know and be able to do to learn effectively and live productively in an increasingly digital world ...”  
1. CREATIVITY AND INNOVATION  
Students demonstrate creative thinking, construct knowledge, and develop innovative products and processes using 
technology.  Students:  

a. apply existing knowledge to generate new ideas, products, or processes.  
b. create original works as a means of personal or group expression.  
c. use models and simulations to explore complex systems and issues.  
d. identify trends and forecast possibilities.  

2. COMMUNICATION AND COLLABORATION  
Students use digital media and environments to communicate and work collaboratively, including at a distance, to support 
individual learning and contribute to the learning of others.  Students:  

a. interact, collaborate, and publish with peers, experts or others employing a variety of digital environments 
and media.  

b. communicate information and ideas effectively to multiple audiences using a variety of media and formats.  
c. develop cultural understanding and global awareness by engaging with learners of other cultures.  
d. contribute to project teams to produce original works or solve problems.  

3. RESEARCH AND INFORMATION FLUENCY  
Students apply digital tools to gather, evaluate, and use information.  Students:  

a. plan strategies to guide inquiry.  
b. locate, organize, analyze, evaluate, synthesize, and ethically use information from a variety of sources and 

media.  
c. evaluate and select information sources and digital tools based on the appropriateness to specific tasks.  
d. process data and report results.  
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4. CRITICAL THINKING, PROBLEM-SOLVING & DECISION-MAKING  
Students use critical thinking skills to plan and conduct research, manage projects, solve problems and make informed 
decisions using appropriate digital tools and resources.  Students:  

a. identify and define authentic problems and significant questions for investigation.  
b. plan and manage activities to develop a solution or complete a project.  
c. collect and analyze data to identify solutions and/or make informed decisions.  
d. use multiple processes and diverse perspectives to explore alternative solutions.  

5. DIGITAL CITIZENSHIP  
Students understand human, cultural, and societal issues related to technology and practice legal and ethical behavior.  
Students:  

a. advocate and practice safe, legal, and responsible use of information and technology.  
b. exhibit a positive attitude toward using technology that supports collaboration, learning, and productivity.  
c. demonstrate personal responsibility for lifelong learning.  
d. exhibit leadership for digital citizenship.  

6. TECHNOLOGY OPERATIONS AND CONCEPTS  
Students demonstrate a sound understanding of technology concepts, systems and operations.  Students:  

a. understand and use technology systems.  
b. select and use applications effectively and productively.  
c. troubleshoot systems and applications.  
d. transfer current knowledge to learning of new technologies. 
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ESLRS 
REDLANDS HIGH SCHOOL EXPECTED SCHOOL WIDE LEARNING RESULTS 
Redlands High School will prepare its graduates to: 
THINK AND LEARN 
é Collect, understand, and process information 
é Analyze, evaluate, and integrate ideas 
é Apply knowledge 

COMMUNICATE 
é Listen attentively 
é Read and write effectively 
é Speak confidently 
é Present ideas and concepts creatively 

COOPERATE 
é Be a team player 
é Respect diversity 
é Exercise self-discipline 

CREATE 
é Set high standards and challenging goals 
é Produce intellectual, practical, artistic, and physical works 
é Achieve pride through meaningful accomplishments 

CHOOSE 
é Recognize opportunities and identify consequences 
é Use time effectively 

 


